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New Features for Version 2019 

Rotated Text in Cells and Ability to Suppress Gridline at Bottom of Any Cell 

It is now possible to rotate text in cells. It can be rotated to 90 or 270 degrees. This is useful when 

someone wants to use rotated text to categorize groups of task rows: 

 
Notice that the horizontal gridlines 

do not enter the vertical text area. 

This is accomplished by using the cell 

by cell option to hide the bottom grid 

line: 

 

This new option to hide the bottom 

gridline in a cell makes it easy to 

group cells using a solid background 

color and hiding the gridlines. 

Note: When cell text is rotated, only 

text to the first hard return is included. Rotated cell text will be displayed outside of the cell which is 

what allows it to overlap other rows. When the text is altered only the column is redrawn. So if the text 

was showing above or below the column there may be remnants left which will go away when the 

screen is refreshed. 



 

2 
 

“Redo” Functionality added 

We’ve added Redo functionality to Milestones Professional 2019. Now, when you press Undo, the 

current schedule is first saved as a Redo. This effectively allows you to go backwards and forwards 

through different versions of your schedule to see the effect of various changes. 

You might want to quickly show some colleagues some variations on your color theme, or some 

symbology changes on your Toolbox. With the new Redo functionality, this is much easier. 

 

The number of Redos available is limited by the number of Undos available. You can set your maximum 

number of Undos / Redos in the Tools Tab > Edit Options. 
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Borders around Single Cells or Groups of Cells 

It is now possible to place a border around any cell. You can use 

partial borders to build a larger border around a group of cells. In 

this example below a group of cells has a border around a group 

of cells containing vertical text:  

 

 

 

The way this is done is that you first select a cell and then use the 

Cell Border control at the right of the Cell menu to set the border 

color, border type, and which parts of the border should show: 

top, left, right, and bottom:  
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Allow Cell Text to Overflow Cells 

You can click on any cell any set the new option that allows text to overflow its cell: 

 

There are two new controls used with this feature. The first checkbox (circled above) “Allow Text to 

Overflow from Cell” tells Milestones to ignore the cell boundaries when displaying the text.  

The other option “Hide Right Grid” (also circled above) tells Milestones to not draw the right side 

column boundary of a cell.  

In the example above, in the first row, the middle cell has the “Allow Text to Overflow from Cell” is set. 

In the example above, in the first row, the leftmost and middle cell have the “Hide Right Grid” options 

set. 

In the example above, the option to center text is set. The text will be centered on the cell in which the 

text is entered. The text will not be wrapped unless it goes beyond 11 times the width of its cell. 

If the text is left justified, it aligns at the left border of the cell in which it is entered. The text will not be 

wrapped unless it goes beyond 11 times the width of its cell. 

If the text is right justified, it aligns on the right border of the cell in which it is entered. The text will not 

be wrapped unless it goes beyond 11 times the width of its cell.  
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Copy and Paste Legend 

You right-click on the Legend Area and select 

Copy Legend:  

When the Legend is copied, a dialog box appears 

explaining how to paste the legend and the 

effects of the Toolbox settings, i.e., you are 

warned that symbols and connectors are pulled 

from the current Toolbox and that it may be 

necessary to also copy/paste the Toolbox to 

ensure that the symbols and connectors are the 

same when pasted.  

To paste the Legend, you right click in the Legend area 

on the target schedule (which must be open in the 

same session) and select Paste Legend: 

 

 

 

 

Note in this example, the Toolbox was not copied so 

the symbols and connectors are different, but 

everything else is the same. 
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Blank Individual SmartColumn Cells 

You can now select individual cells and have the SmartColumn data blanked out. In prior versions you 

could only blank an entire row. 

 

You can still blank an entire row, but now have the additional cell by cell control. Note that the blanking 

of an entire row overrides any individual settings.  
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Improved Percent Complete View 

In prior versions the percent complete view 

replaced the schedule area in each row with a 

bar showing the percent complete from 0 to 

100. The bar size was based upon the symbol 

size. The embedded text used the symbol font 

and size but was always black: 

 

 

 

 

 

 

In version 2019, there are extra controls under Tools | Program 

Options | General, that let you control the bar size, add in task name, 

vary the bar colors by cycling through the ToolBox bar colors, and 

normalize the bar length based upon the largest percent complete. 

You can also specify an alternate column from which to pull percent 

complete values. The color of the symbol text is also respected and 

will invert if its visibility is hampered by the current bar color of the 

row: 

The view as a result of the setting changes is shown below: 
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New Legend Border Options 

You can now alter the border of the Legend. By default, the Legend always uses the current schedule 

frame line width and color. Using the new options, you can leave the Legend border at its default 

settings or alter the border. This option is most useful when the Legend is floating, but the settings are 

also respected when the Legend is in its normal attached position at the bottom of the schedule. The 

settings are in the Full Legend Selection Toolbar: 

 

The very first line type option in the Alternate Border dropdown is “Default”, which uses the traditional 

Legend border. If Default is selected, then the alternate border color is ignored. 
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Fill Pattern Selection Box for Connector Made Larger 

The pattern selection for connector bars has been made 

larger to make it more difficult to select a pattern when you 

intended to select a solid fill: 
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Removal of Various Cell by Cell Overrides 

In the Tools menu, you can now select an option that lets you remove various cell by cell overrides for 

either the current column or the entire schedule: 

 

For the column-only override option to be active you must select either a column heading, column, or 

column cell in order to specify the column. 
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Find/Replace All Feature added to Edit Menu 

The new Find/Replace All button in the edit menu lets you find all occurences of a text string and have 

the results displayed in a dialog box: 

 

The dialog box lets you enter the string, then search for it or Search/Replace if the Replace with: box is 

checked, and then, once the results are displayed, you can select any result and press the Go To Current 

Selection button. If you selected Replace, you can Undo the changes made while in the Search/Replace 

dialog by pressing the Undo button (if you have the Multi-Undo feature active undo Tools Program 

Options | Edit). 

When you go to the current selection, the object is selected and the Toolbar changes to display the 

item, as if you had clicked on it with the mouse: 
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Strikeout Text Attribute Added to all Text Setting Menus 

Everyplace you can set bold, italic, and underline now lets you also set strikeout: 

 

 

The icon is an S with a line through it: S. 

Note that, like with all other Milestones text settings, the strikeout applies to the entire text block, not 

just individual characters, so its utility may be somewhat limited. But we have had a few users ask for it 

over the years. 
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DataGraph Alternate Font Size for Graph Section 

It is now possible for an alternate font size to be used in graph section of a DataGraph. This is useful if 

you want the Legend part of the DataGraph to use a different font size: 

 

The setting is made using DataGraph Text setting in the Format menu: 
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Symbol Hyperlink Hotspot Improvements 

In PDF files, the symbol hyperlink is now nearly twice as large. In HTML files, you can now specify that 

only the first hyperlink is to be included in the symbol hotspot.  

 

All will still be listed if that option is turned on. 
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New Symbol Report: Symbol Type Usage Report 

This new report creates a table of symbols found either on the schedule or in a column. It is useful for 

comparing number of events.  

In the sample below the column containing Root Cause is analyzed. The counts and percentages show 

that most of the causes were related to configuration issues, while only 5 percent of the issues were 

related to bugs: 

 

The settings you do in the dialog are remembered so long as you exit the dialog by pressing OK. They are 

then saved with the file. 
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Curtains Now can be Shown in DataGraphs 

A new option in the Curtains dialog: 

 

 

lets you show curtains in the DataGraph even if you don’t show them anywhere else: 
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New Freeform Text Substitutable Strings 

The following substitutable strings have been added to Freeform Text: 

&coltotCC, where CC is the column number from 1 to 20. The total of the numbers in the column will be 

substituted. Note that outlining is respected, so any numbers in a Summary row are ignored. 

&colavgCC, where CC is the column number from 1 to 20. The average of the numbers in the column will 

be substituted. Note that outlining is respected, so any numbers in a Summary row are ignored. Also, 

any values of zero are ignored to ensure that rows intentionally left blank are ignored. If there are valid 

values of zero, then the average will not be correct. 

&colCCsymSS, where CC is the column number from 1 to 20 and SS in the Toolbox symbol number from 

1 to 64. The total number of symbols of Toolbox type SS will be substituted. 

An example of the use of these strings is shown below: 

 

 

Note that the column numbers and symbol numbers are shown. 
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Feature to Show Symbol Numbers and Connector Numbers in Toolbox Added 

You can right click on the Toolbox and select the option to show symbol and connector numbers. This 

makes it a little easier to figure out a symbol or connector number when you need it to use elsewhere, 

like in a &symbol command or in a substitutable text string or in an automation program. 
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You Can Now Set the Title Border Line Color and Type 

By default, the border drawn around the title uses the same line type and color as the frame lines 

around the schedule. You can now alter these title border lines to whatever color and type you want: 

 

 

By default, no overrides are set: 
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Improved Startup Choices Dialog 

The enhanced Startup Choices dialog now displays a large preview of each accessible Milestones files in 

the list of 16 possible previously used files: 

 

Only Milestones files are displayed, not MPP files. Any files in the list that cannot be opened, such as 

deleted files or temp files that were opened as Outlook attachments are also left out. Any files without a 

Preview image are a Thumbnail image are shown as Milestones icons. See the circled icon in the above 

image. 

Most of the time 3 rows of previews are displayed and you can use the horizontal scroll bar to see all 16 

possible previews. 

This new Startup dialog does not act the same as the legacy dialog in that it does not let you set 

permanent Startup choices. If you revert to the legacy dialog you can set a permanent startup choice, 

such skipping the dialog and then always opening the most recent file, etc. 

There is a button in the dialog that lets you revert to the Legacy Startup dialog, which continues to work 

the same as in prior version of the software. The legacy dialog also has a similar button which lets you 

revert to the enhanced startup dialog. These legacy vs. enhanced dialog choices are remembered from 

session to session. 

Since this can be a large dialog box, there are multiple possible sizes that are used, depending upon the 

main screen size of the computer and the current display scale setting. By default, Milestones 

automatically tries to select the best size to use of the four possible sizes, compact, small, medium, and 

large. 
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The compact size is automatically chosen if the height of the main monitor is less than 1080 pixels. 

In cases where Milestones is not running on the main monitor, but instead runs on a secondary monitor 

that may be a different size, you can pick which of the four possible sizes to use in the Tools | Program 

Options | Files and Automation screen: 

The option selected is remembered and is used 

from then on, until changed in the same screen. 

People uncomfortable with too many choices may 

also prefer the Compact size screen regardless of 

monitor size as fewer thumbnails are shown. 
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Improved MRU List Display in File Menu 

The dropdown display of the most recently used files in the File menu has been improved to include 

thumbnails of the files (where possible) to make it easier to determine which file to open: 

 

Milestones files which have no thumbnail embedded display a Milestones icon. MS Project files in the 

list are shown next to an MS Project icon. 

If you wish to show just a list, as in previous versions, you can uncheck the Show Thumbnail in File Dialog 

option in the Tools | Program Options | Files and Automation screen: 
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ValueSets have more Zero Value Display Options 

By default, any trailing zero values in ValueSets are never displayed. This was done to prevent an 

unwanted drop to zero for line and point graphs at the end of the data. 

However, there are cases where you may wish at least one trailing or all trailing zero values to be 

displayed. This is done in the ValueSet Properties dialog, Graphic Properties screen, where two new 

options have been added: 

 

The setting is available for each ValueSet. 
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New Space Saver Option in Legend 

The new Legend Option “Use All Available Space for Single Symbol Entries” causes the text associated 

with the Legend entry to be moved left if there is room even if other entries cannot be moved. 

 

 

 

Before this option, the text would only be shifted left if all Legend entries just had a single symbol. 
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Now 2450 Task rows or Symbols can be selected – Up from 450 

In the past only 450 task rows or symbols could be selected at the same time. Now the limit is 2450. This 

is useful when using the Select all Symbols of the same type feature, or when lots of task rows need to 

selected at the same time. 

Color Theme Changes 

Categories for Color Themes removed. Now all Color Themes are listed alphabetically. If the “Aqua” 

theme is missing, then all themes will be replaced with the default set which comes with Milestones 

Professional (the “ColorThemes2019.txt” file in the Milestone system folder. 

Symbol Note default colors now saved with theme and new checkbox added to allow all notes to get 

new color from theme. 

Frame color for title and legend now part of theme. 
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You can now import color themes from prior version 2015 and 2017: 
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Clear Values Added to ValueSet Edit Dialog 

It is now possible to clear the values of an existing ValueSet. It the button is pressed, all values are 

changed to 0.0: 
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Can Now Suppress ValueSet Legend in DataGraphs 

 

This will help in cases where the left side column area is not wide enough to allow the legend to be 

shown cleanly. 
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Watermark Layer for Freeform Text and Graphics 

Freeform Text and Graphics images can now be designated as watermarks. When this flag is set the 

objects are drawn on top of any grids or shading, but under symbols and bars: 

 

In all cases the text or images to be used in the background should be a light color to avoid obscuring 

the text, bars, and symbols that lie on top. Light gray is usually a good choice.  

Note that the Freeform text watermark layer is on top of the graphic image watermark layer. 
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Freeform Text Angles of 30 and 45 degrees Added 

2019 now supports freeform text at 30 and 45 degrees. Note that background colors and outlines are 

not displayed when these 2 angles are chosen: 
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New Connector: Type 73 

A new non-date sensitive connector has been added. It always has a white dashed line running through 

the center: 
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Override Vertical Link Type 

You can now override the vertical link type of any of the 5 links coming from a symbol. You can use any 

of the 8 link types available in the Toolbox. Note that the override link type retains the color and line 

type (from Toolbox or Override) as the existing link. 
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Improved Open Sample Dialog and Dedicated Toolbar Button 

There is now a dedicated Open Sample toolbar button and an improved Open Sample dialog which 

shows large thumbnails of all the samples in each folder: 

 

In the past the samples were hard to discover since you had to click the down arrow next to the Open 

button. 
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Alternate Schedule Border Color and Line Types now Possible 

Now you can specify and alternate border color and line type. Instead of just the 4 solid lines you can 

now choose any of our standard 28 types: 
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New Split Summary Bar Option 

You can now just show symbols when you pick the Split Summary Bar Option: 
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Improved Print Screen 

The default print screen has been improved to automatically show a preview: 
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Improved Start New Schedule Wizard 

The start a new schedule has been improved to allow easier selection of start-up templates: 
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ISO Date Formats 

The International Standards Organization (ISO) is the group that defined what an ISO week is, i.e. the 

first ISO week of a year always includes the first Thursday of year. ISO weeks always start on Mondays, 

and the first week may actually start in the prior year depending upon where the first Thursday of the 

year falls. All Years have either 52 or 53 ISO weeks. 

There is also a date format associated with ISO weeks. In all places in Milestones where your can specify 

a custom date format, we have added the ability to specify ISO formats ISOA to ISOP (12 formats in all). 

ISOD, ISOG, ISOM, and ISOO are not used. They do not have to be capitalized when used. See the sample 

below: 

 

 

 

 

 


